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IPMIView (IPMI-Over-LAN)

1. Overview

IPMIView is a management software program based on the IPMI specification Reversion 1.5 - 2.0. IPMIView
sends IPMI messages to and from the BMC (Base Management Card) on a host system at a remote location.
IPMI messages are encapsulated in the RMCP (Remote Management Control Protocol) packets called
“datagrams.” This method is also referred to as “IPMI-over-LAN.”

According to the Distributed Management Task Force (DMTF) Specification, RMCP is used for system
management in a pre-OS or an OS-absent environment. RMCP is a simple request-response protocol that can be
delivered using the UDP (User Datagram Protocol) datagrams. IPMI-over-LAN uses version 1 of the RMCP
protocol and packet format. An RMCP packet is transmitted via an IP (Internet Protocol) networking, which
will allow system managers to manage their IPMI-enabled systems over the Internet. In a private LAN network,
this is a basic feature. IPMI uses the same UDP port number (623 in decimal) as the ASF (Alert Standard
Forum) protocol. If the managed system is protected by a firewall, UDP port 623 must be opened.

In Supermicro’s IPMI solution, a BMC (Baseboard Management Controller) shares the LAN1 NIC on the
mainboard. (If there are more than one LAN Ports on the mainboard, LANL1 is the one closest to the
Keyboard/Mouse Port.) The NIC will re-route the IPMI packet to the BMC instead of forwarding it to the
upper layer of the network protocol stacks as other protocol packets do.

IPMIView V2.0 covers Supermicro’s BMCs for both IPMI v1.5 and IPMI v2.0. However, due to design
changes, some functions may not be available for IPMI v1.5, while others, might no longer be available for
IPMI v2.0. IPMIView will automatically hide any functions that are not available based on the BMC version
used in the system.
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Figure 2-1

As shown in Figure 2-1, there are several components in the IPMIView window (Figure 2-2):

1)
2)

3)
4)

5)
6)

7)
8)

9)

Menu Bar: contains functions that allow you to add/delete systems or groups and save configurations.
Toolbar: contains functions that allow you to execute commands quickly. Click the icons on the toolbar
to add a new system, save the current configuration settings, to discover IPMI devices, to access group
management, to discontinue the IPMIView section and to access the help menus. See Figure 2-2 for
details.

Logo: Click the Logo icon to visit Supermicro’s website.

IPMI Sorting: This allows you to sort devices in an ascending/descending order via the online format, or
in the original sequence.

System List: This lists the computers managed by the BMC Controller.

Group management: This allows the user to manage system groups, including creating/adding new
accounts, deleting accounts and update group information.

Group List: It lists computer groups managed by the BMC for better management.

Viewing Window: This shows detailed information including Login, IPMI Device, Event Log, Sensors,
BMC Settings, and the status of the IPMIView firmware.

System View Sessions: IPMIView can manage up to 20 systems at any given time. The systems that are
currently managed by the BMC are indicated in the System View window.
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10) Bottom Toolbar: This toolbar contains function tabs that allow you to execute commands quickly. The
tabs allow you to access the following submenus: Login, Event Log, Sensors, IPMI Device, BMC
Setting, Users, Text Console, KVM Console.

T IPMI View ¥2.6.20 (build 070927) - Supes Miczo Computer, Tnc.
Fie Bdit Mansge Help

BE e Od e R
SUPERMICR®

i IPMI Domain 2 ¥ O 7t 4
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IPMI View

Intelligent Platform Management Interface

IPMI 2.0/1.5 over LAN

Ready

Figure 2-2
ToolBar (Top)
The toolbar provides you with direct access to the features that are used frequently (as shown in Figure
2-3). You are able to switch between server- and group- management. The following toolbar shows the
items that are currently available for user configuration under the BMC management.
Add a new System

4 Save configuration
4 Discover IPMI device

Switch to server management
L Switch to group management

LL Close session
b

Bl Q|

Show trap Info
About
Figure 2-3



e Adding a new system

Click <File>"New>System” to add a new system to the IPMI connection (as shown in Figure 2-4). An
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Figure 2-4

“Add a new system...” dialog box will display as shown in Figure 2-5.

In the “Add a new system” dialog box, enter the System Name for the system to be managed by the
BMC, its IP address, and its description. Then click <OK>.

e Adding a new group

For better system management, the manager may group systems in different groups. A system may be
included in multiple groups. The default group is the “IPMI Domain.” All systems under the BMC
management belong to the IPMI Domain even if they are also grouped into other groups.

Click the menu: <File>"New...>Group” to add a new group to the IPMI connection.

& Add a new system. ..

System Marme:

IP acldress: | 0.0.0.0

Description: | DESCRIPTION

B=1ES

Figure 2-5

An “Add a new group” dialog box will display as shown in Figure 2-6.



£ Add a new £T0ND

Group Mame: | AESEETITS

Description: | DESCRIPTION

Figure 2-6
In the “Add a new group” dialog box, enter the Group Name and its description. Then click <OK.>

e Discover IPMI Device

IPMIView offers a feature that will detect all devices or systems currently connected to the network.
The user may specify a Network IP address range, and the network Mask, then click <Detect> or
<Start> to search any IPMI devices or systems that are connected to the IPMI 1.5 or IPMI 2.0
connections as shown in Figure 2-7. Click <Exit> to discontinue this process.

£ JPMI Deyice Discoyering @

Metwork P From | [EERICRIE]

To [15216810 254
Network Mask | 255 365 265 1
Search Option

PMIZ0 [C]IPM1S

Start Exit

Found: 2

P Mame Wersion
192.166.10.241 [192.168.10 241 [iPwa 2.0+ |
192.168.10 246 _[192168.10 246 Pmi 2.0 |

Figure 2-7

e Reload Configuration

From the pull-down menu, click <File>"Reload Configuration” to load the configuration settings that
were previously saved.

e Save Configuration

From the pull-down menu, click <File> “Save Configuration” to save the current configuration settings.

e Update Firmware

From the pull-down menu, click <File> “Update Firmware,” and select the system you wish to update
from the IPMI Domain list on the left side of the window. A Confirmation dialogue box will appear.
Click <OK> to update the IPMI Firmware. Click <Cancel> to discontinue this process.
From the pull-down menu, click “File>Save Configuration” to save the current IPMIView configuration
settings.
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e Language

From the pull-down menu, click <File> “Language” to activate a Language submenu. From the
submenu, you can select Chinese (Taiwan), Chinese (China) or English (USA) as your IPMI language
setting.

o Exit
From the pull-down menu, click <File> “Exit” or press <Alt-F4> to exit IPMIView.
e Modify System

Select a system in the System Window you want to modify and click <Edit> “Modify System” to
modify it from the pull-down menu as shown in Figure 2-8.

You can also right click on a system in the System Window and select “Modify” in the pop-up menu to
modify it.

e Modify Group

Select a group in the Group Window you want to modify and click “Edit>Modify...>Group” from the
pull-down menu shown in Figure 2-8 to modify it.

You can also right click a group in the Group Window and select "Modify” in the pop-up menu to
modify it.

File Semion Menage Help

Modify = -
B iy . % ©

S TPMI Secuity Group | |] B 102.168.10

Join I_L/l{.
Disjain |
% Refrech veE®

Al 192.168.10.243

Figure 2-8

e Delete System

Select a system in the System Window you want to delete and click <Edit> "Delete System” from the
pull-down menu as shown in Figure 2-8 to delete it.

You can also right click on a system in the System Window, and select “Delete” in the pop-up menu to
delete it.



e Delete Group

Select a group in the System Window you want to delete and click <Edit> "Delete Group” from the
pull-down menu to delete it as shown in Figure 2-8.

You can also right click a group in the System Window, and select “Delete” in the pop-up menu to
delete it.

e IPMI Security

From the pull-down menu, click <Edit>"IPMI Security” to activate the IPMI Security dialogue box.
Check Auto Detection for IPMIView to automatically check the current IPMI status. Check the
Advanced User box to select the following protocols as shown in Figure 2-9.

® Hardware: BMCB, Firmware:IPMI 1.5:
® Hardware: BMC2, Firmware:IPMI 2.0 (non-RMCP+):
® Hardware: BMC2, Firmware:IPMI 2.0 (Standard RMCP+).

Check the Encryption box to use encryption supported by the IPMI 2.0 Standard RMCP+. All packets
transmitted from IPMIView to the BMC system management will be encrypted.

IPMI Protocol X

9P IPMI Protocol for Hew System

_\_\___C

(73 Auta Detection
For Advanced User. Select Following Protocols based on HW and Fw
() Hw - BMCE, Fw': IPMI 15
O HA: BMC2, FW: IPMI 2.0 nan-RMCP+
(&) Hw' : BMCZ, P/ : IPMI 2.0 Standard RMCP+
Encrplion

Hw = Hardware
Fiaf = Firmware
Figure 2-9

e Joinagroup

Select a group in the Group window, a system in the System Window, and click <Edit “Join” from the
pull-down menu to include (to join) this system into the group as shown in Figure 2-8.

e Disjoin a System or a Group

Double click the group from which you want to disjoin a system. The systems that are included in the
group will appear in the System Window. Then, select the system you want to disjoin from the group,
and click <Edit> “Disjoin” from the pull-down menu shown in Figure 2-8. You can also select a group
from the Groups list and click <Edit> “Disjoin” to remove it from the IPMI groups.
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You can also right click the selected system, and select “Disjoin” in the pop-up menu to remove it from
the group.

Refresh

Double click the group from which you want to disjoin a system. The systems that are included in the
group will appear in the System Window. Select the system you want to refresh, and click <Edit>
“Refresh” from the pull-down menu to refresh the system as shown in Figure 2-8.

Timeout

The timeout setting is shown in Figure 2-10. Timeout is the period for IPMIView to wait for a response
after sending a command to a managed system. If a response is not received from the managed system in
the timeout period, IPMIView will resend the command to managed system again. You may specify the
timeout value (in seconds) to get a quicker response from the managed system. You can also specify the
number of times that IPMIView will resend the command.

Setting

U ] Timeout for retry [zecond] 2
\-."(/

Humber of retry 20

oK Zancel

Figure 2-10

Section

IPMIView will display the IP address(es) currently connected to the network when you click <Section>
from the toolbar. You can disconnect the IPMI connection from a system currently connected to the
network by clicking “Closing. (the IP Address) “.

Fie  Edt Help

@™ Q@ RO .

Setting... .
SUFERvIICR®

B 1PMiDomain . & v § £ @
) New Systeml m
192,188,227
) New Systenz
Zh1a21681.188
& 192168138

IPMI View

Intelligent Platform Management Interface

IPMI 2.0/1.5 over LAN

 EEE@
)omain (15)

Figure 2-11
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e IPMIView Management

IPMIView allows you to manage your server or your network group by selecting <Manage>
“Server/Group” from the pull-down menu as shown in Figure 2-11.

In addition, you can also configure Group Login Settings by selecting “Setting” from a pull-down menu
under the <Manage> tab. A dialog box will appear, prompting you for the Login ID and Password. Once
enter the values in these fields, click <OK> to access the page and configure the settings. Please note
that this feature is available for the system administrator only.

e Help

Select <About> to display the information on the systems connected to the network.
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3. Login
e Login

Click the <Login> tab on the bottom toolbar as shown in Figure 3-1. A login screen along with some
information about the managed system will appear in the Viewing Window. Enter the login ID and
password, and click the <Login> button to log in. When login is successful, the connection information
will be shown at the bottom. The Login button is grayed (disabled), and the Logout button as well as
other available management functions will be enabled. as shown in Figure 3-2.

Fie Fdt Sewsin Maagn Helo

lpsagooe e
SUPERMICR® |~

Ml Doman A ¥ R
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) vz 1e80 207 .
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LogniD | ADMIN

[ save D v Piiwend

[ Legn

s X L]
IPMAI Do [1./8)

Figure 3-1
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[=] s 103 s Pusrword

Lagnot

EG‘""’“ Y TL CONNECTED

TPM] Duiman $44)

Versom : [FM1 200 RMCE
Ciphis Sniw : RAKF-RMAC-SHA1, RMAC-SHA1-05, ARS-CRC-128

Logn | Eveatlog Sensors 1P Dwvice | DMC Seting | Usss | Teod Comsole | KVH Console | Virtal Medin,

RMCR+ Oopar, Sassitn micasstul

Figure 3-2
The default Login ID and password are “ADMIN”. Both are case-sensitive.

In IPMIView, an MD5 algorithm will encrypt the password when it is transmitted through the network.
(If you are connecting to the IPMI 2.0 RMCP+, all the data will be transmitted by an encrypted
algorithm.) Once the password is confirmed, IPMIView will show a CONNECTED symbol, and all
available function pages will be shown as in Figure 3-2. If the password is invalid, a message will be
displayed in the Status Area that reads, “Unable to activate a session, please check ID and Password.”
and a Break symbol will be shown (see Figure 3-3).
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In order to reduce overhead on the managed system, all pages will not be refreshed automatically. The user
must refresh the pages manually as needed.

After logging in, the IPMIView main window will display as shown in Figure 3-2. A tool bar will
display on the bottom of the screen for your convenience.

e Bottom ToolBar
As shown in Figure 2-4 below, this toolbar contains function tabs to allow you to execute commands
quickly. The tabs allow you to access the following submenus: Login, Event Log, Sensors, IPMI Device,
BMC Setting, Users, Text Console, KVM Console.

Login
Event Log
Sensors
T IPMI Device

Laogin | Evertt Log | Sensorz| IPM Device | EMC Setting [ Users | Text Console | EWM Conscle]

|

BMC Setting
ser
Text Console
KVM Console
Figure 3-4
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4. Event Log

After you have logged into a system, the screen as shown in Figure 4-1 will display. Click the <Event
Log> tab on the bottom toolbar to activate the Event Log screen as shown in Figure 4-2.
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et SEL Tomer sucomeded

Figure 4-2

e System Event Log

All: Click this radio button to select all events.

From...to: Click this radio box to select a portion of events.

Get: Click this tab to get the event logs.

Export: Click this tab to export event logs to a file.

Clear All Entries: Click this tab to clear all event log entries.

Current SEL Device Timestamp: This item displays the timestamp of the current SEL device.
Set Timestamp: Click this tab to set the timestamp for the system selected.

Refresh: Click this tab to refresh this page.
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5. Sensors

This feature displays the status of each sensor used to monitor system health as shown on Figure 5-1.

M1 s V2,710 (bulld 091124) - Super Micra Computar, Inc.

Fin Edk Seiskn Manoge  Hiks
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o 1971881 3
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’ o Hiny

Logn| Event Log| Sersos | IPM Devce | BMIC Sefting | Usees| Teaf Cananka ]| £V Consnle
| Ritrestong cermers’ itohs compheted

Figure 5-1

Fans: This window displays fan status.

Voltages: This window displays voltage readings for various devices.
Temperatures: This window displays temperature readings for various devices.
Sensors: This window displays the devices being monitored.

Refresh Every X seconds: Enter the number of seconds for the system to refresh.
Refresh Now: Click this tab to refresh the Sensors page immediately.

Save Layout: Click this tab to save the current layout setting.

Hide inactive item: Check this box to hide inactive items.

Show History: Check this box to display the sensor records.
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6. IPM Devices

Click the IPM Device tab of the IPMIView management session in the Viewing Window (shown in
Figure 6-1) to display the information and functionality of the BMC firmware installed in the system.

Fle Edt Session Manage Help

© he

0l a gl @ R
SUPERMICR® |~

0 PMIDomain© A v Q@ & @

192 1

1681188
) New System?
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Gl ACP| Power Stale sucossded

e Device Information

192.168.1.38

Device Information

Firmware Revision 09.99
IPMI Revision 2.0

ACP| System Power State 50460

On

=) 1821681227 Graceful Power Control

LC=CEINESHTADIV

Chassis Power Control

Leoveniown R EoWerUp R Eoweroycle N (JRCEer ]

BMC UID LED

[ codReset | Blink UID LED

Login|| Evert Log| Sensors | [Pk D evics BMC Setting| Users|| Text Console| KvM Corsols]

Figure 6-1

This shows the revision levels of the BMC and IPMI firmware.

e ACPI System Power State

This shows the power state of the managed system. If the managed system is in a power-off state, the
green light will be off. It will be updated automatically every five seconds.

e Graceful Power Control (Administrator and Operator only)

Graceful power control will inform the OS running on the managed system to shutdown, reboot and
reset the power-cycle within a specified time. (The default setting is 30 seconds). When the OS running
on the managed system receives a graceful power control request, it will generate a pop-up window on
the monitor of the managed system, and start to count-down. This pop-up notice window will give the
user working on the system an opportunity to save any working files. However, remote login users or

service users (e.g. Web site visitors) will not see this notice.

Graceful Shutdown: This feature has the same function as “shutdown” in the Windows. Using this

feature will cause the managed system to enter the S5 state.

Power On Icon: Click on the Power-On Icon to power on or power off the device.
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e Chassis Power Control (Available for the Administrator and Operator only)
This feature is used to manually control the power state of the chassis of a managed system. When the
BMC receives the power control command from the chassis, it will have direct control over the power
button or the reset button of a system.

Power Down: This feature will power off a managed system as it would when the Power-Down button
of the chassis is pressed.

Power Up: This feature will turn on the power of a managed system as it would when the Power-Up
button of the chassis is pressed.

Power Cycle: This feature will turn off the power of a managed system for a few seconds and then turn
on the power of the system again.

Reset: This feature resets a managed system as it would when the Reset button of the chassis is pressed.
e BMC Cold Reset (for the Administrator only)
Clicking the Cold Reset button allows you to reset the BMC. After confirming the reset of the BMC, the
session will be terminated immediately. The user has to close this session manually. This feature is
rarely used. It is only used for an event when you suspect a system malfunction for example.
e UID (Unit Identifier) LED
Blink UID LED: Click this table for the UID LED to blink when the unit in question is identified.

e Refresh

Click this tab to refresh this page.
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7. BMC Settings (Available for the Administrator only)

BMC LAN Configuration

IP hddress LAN MAC
Gateway [P DHCP
Subnet Mazk L AN MAC must be correct while vpdate
VLAN Tag |g [[] Ensble VLAN tagging
SNMP
Conmty b
SNMF Trap Receivers 1P Addres
0.0.0.0 »
0.0.0.0
0.0.0.0
0.0.0.0
0.0.0.0 o
LAN Inferface
) Dedicated ) On Board LANL ) Fadlover
Login | Event Log || Sensors | [PM Device BMCSeﬂmg Users | Text Console | K¥M Consale
Figure 7-1

Click the BMC Setting tab of the IPMIView management session in the Viewing Window (as shown in
Figure 7-1) to display detailed information on the BMC LAN Configuration, SNMP trap configuration
and the serial port status.

BMC LAN Configuration

This feature displays the IP address, the LAN MAC, the Gateway IP, the Gateway MAC and the Subnet
Mask of the BMC and allows you to modify these settings. NOTE: please make sure that the MAC
address of the LAN and the gateway for the BMC are correct before updating it by clicking the
<Update> button. Be careful to enter the correct values especially for the LAN MAC. If you enter the
wrong LAN MAC, IPMIView will not be able to connect to that system any more.

If you accidentally enter a wrong LAN MAC value, you may use the IPnMAC.exe command in the
IPMI Solution/Utility subfolder on this CD to update it. To activate IPnMAC.exe.,which is a DOS
command, you must first boot your managed system to DOS, and then execute IPnMAC.exe on the
managed system. You can also enable the VLAN (Virtual LAN) Tag setting by clicking on the “Enable
VLAN Tagging” box on the right and enter the value on the VLAN Tag field to configure VLAN Tag
setting.

SNMP

This displays the SNMP trap configuration of the system that needs to receive the SNMP traps generated
by the BMC to allow you to modify the settings. To change the configuration on the BMC, enter the
SNMP community name in the Community text field, and enter the IP address as well as the MAC
address in the SNMP Trap Receivers table in the SNMP group. Then, click the <Update> button.
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The SNMP Trap may have multiple destinations. When any critical error occurs, an SNMP trap packet
will be sent to all receivers in the list. To remove an SNMP receiver, you may change both IP and MAC
addresses to 0.0.0.0 and 00:00:00:00:00:00 respectively. Then, click <Update>.

For a system to receive the SNMP traps, you must install and run an SNMP trap receiver program. The
managed system will send out an SNMP trap packet to all receivers when an event occurs. If an SNMP
trap receiver is not running, the trap packet is discarded, and cannot be queued anywhere.

e RS232/ MODEM (available for IPMI 1.5 only)
This displays the configuration of the RS232 interface on the BMC. It is used to initialize the RS232
port and the installed modem, if any. The RS232 port is the box-header (Figure 7-2) on the BMC, and a
dedicated serial port.

Baud Rate: It is the baud rate for serial connections, which will not affect paging settings.

Modem Init String: This is the modem initialization string for serial link connections, which will not
affect paging settings.

Figure 7-2

e LAN Interface

e Dedicated: Click this radio box to use the IPMI-Dedicated LAN as the default LAN connection.

e Onboard LANZ1: Click this radio box to use the onboard LAN port 1 as the default LAN
connection.

e Failover: Click this radio box to enable Failover support.

e Update: Click this tab to update LAN connection status.

e Refresh: Click this tab to refresh the page.
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8. Users
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Figure 8-1 (For IPMI 2.0)
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Figure 8-2 (For IPMI 1.5)

Click the Users tab of the IPMIView management session in the Viewing Window (as shown in Figure

8-1 and 8-2) to display detailed information on the Users management, and paging severity thresholds
for IPMI 1.5.

We strongly recommend that you change the password immediately for security reasons.
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USERS

User Name

IPMIView allows you to add or delete a user, to change a user’s password, to set and update user
privilege settings by clicking the appropriate tabs.

Privilege

This feature allows you to set and update privilege level for a user or delete a user from the list. There
are six privilege levels, Callback, User, Operator, Administrator, OEM, and No Access. Only the first
four privileges are supported. Privilege Levels determine which IPMI commands a user can execute
over a channel. Privilege Limits set the maximum privilege level that a user is allowed to operate at. A
user is granted certain privileges for each channel, and the user can operate at a privilege level that is
granted. Click the “Update Privilege” to change the privilege level setting for a user.

Group Privilege Levels

Callback

This may be the lowest privilege level. Only those commands that are used to initiate a
Callback are allowed. (Available for IPMI 1.5 only.)

User

Only the basic commands are allowed. These commands are used to read and retrieve
data, to modify BMC configuration settings, or to write data to the BMC or other
controllers. Actions such as resets, power on/off, and watchdog activation are not
allowed.

Operator

All BMC commands are allowed, except for commands that can modify out-of-band
interface settings. For example, the Operator is not allowed to disable individual
channels or change a user’s access privileges.

Administrator

All BMC commands are allowed, including modifying commands. An Administrator
is allowed to execute configuration commands that disables the channel over which
the Administrator is communicating.

SOL (Serial-Over-LAN)

This feature allows the user to configure SOL settings. Click “Enable” to enable SOL support. Click
“Update SOL Privilege” to update a user’s SOL privilege level.

Click Paging Setting to set the parameters for an individual user (Figure 8-3). There are two types of
paging services: Numeric paging and alphanumeric paging. To use a paging service, a modem must be
connected to the RS232 connector on the BMC (Figure 7-2).
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& Paging Setting

User Mame | g

Pager Mode (A=

Paging Service Mumber 0912505132

Mutmeric Message | SOOERR

Rocerm Init String | ATL M1 X358=2E

Dial String | ATDT

Update ][ Cancel ” Test Paging

Figure 8-3
e FRU (for IPMI 2.0 only)
This provides useful information on the board and the product, including the serial number, part number,
and the components of the motherboard. Click the “Update FRU” tab to update board information and
product information, including information on the manufacturer, the name of firmware, the serial

number/ the part number of the motherboard, and the part/model number of the BMC firmware, the
version and the serial of the IPMI/BMC firmware.

e PAGING/SEVERITY (for IPMI 1.5 only)

Use paging severity settings to determine when a user will be notified of an entry of the system event
log (SEL).

The following settings are available for each group:

None When this setting is selected, user notification for this group is disabled.

Warning When this setting is selected, the RMC will notify the user when SEL entries for the
group exceed the warning thresholds.

Critical When this setting is selected, the RMC will notify the user when SEL entries for the
group exceed the critical thresholds.

All When this is selected, the RMC will notify the user of all entries of the SEL events for
the group.

All warning and critical thresholds are predefined by Supermicro based on hardware design.
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9. Text Console Redirection (SOL- Serial-Over-LAN)
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Figure 9-1

Click the <Text Console> tab on the bottom tool box (shown in Figure 9-1) to enable Text Console
Redirection support, which will allow you to control a remote system from a text mode console. Click
the <Start> button to start the text console redirection. Click the <Stop> button to stop the text console.

® BMC for IPMI 1.5

Console Redirection is not supported by the IPMI specification V1.5. Supermicro provides this
useful feature for a manager to control the managed system from a remote location. When a
managed system is booting up during the POST routine, and no other software application are
available for you so that you can gain control over console redirection, IPMIView provides you with
this valuable feature. Console Redirection will redirect the monitor of a managed system for
IPMIView use and allows you to send the key codes to the managed system.

When a managed system changes its video mode from Text Mode to Graphics Mode, a termination
notice will be sent to IPMIView to terminate the console redirection. Text Console Redirection only
works with the text mode.

Important Note: Console Redirection can cast a very heavy load on a managed system. It will
redirect the whole monitor to the manager’s system, and it will slow down the managed system
significantly. We suggest that you use this function only when you absolutely need it. For other
applications, a proper console redirection software application (pcAnywhere, Symantec Corporation)
or a remote login protocol (telnet) is recommended. When you finish your remote operation, click
<Stop> to terminate console redirection to take the load off the managed system.
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® BMC for IPMI 2.0

Serial-Over-LAN (SOL) was designed to support Text Console Redirection based on the IPMI
specification VV2.0. This function performs better in IPMI 2.0 than in IPMI 1.5. The Text mode
console is supported by the Windows 2003, even when the OS is running. To support Text Console
Redirection on the Windows 2003, Special Administration Console (SAC) must be enabled. The
following instructions are used to enable the SAC:

1. Enable Console Redirection in the BIOS, and set it to COM 2 (or COM B)
2. Modify boot.ini in C:\. Boot.ini is a hidden file. An example of boot.ini is listed below.

[boot loader]

redirect=com2

redirectbaudrate=19200

timeout=30

default=multi(0)disk(0)rdisk(0)partition(1)\WINDOWS

[operating systems]

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Windows Server 2003, Standard" /fastdetect
[redirect

To enable Text Console Redirection support on a Linux Platform:
1. Host A with the IPMI BMC installed (for the Linux Platform):

a) BIOS POST:
(i) Enable "Console Redirection" in BIOS Setup.
For example, COM2 / 19.2Kbps / 8N1

(i) Disable "Enable Console Redirection after POST" in the BIOS setup.

b) Boot Loader:
(i) For GRUB,
add the following TWO lines into /boot/grub/grub.conf, but
comment out "splashimage=(hd0,0)/grub/splash.xpm.gz"
serial --unit=1 --speed=19200 --word=8 --parity=no --stop=1
terminal --timeout=10 serial console
#splashimage=(hd0,0)/grub/splash.xpm.gz

(if) Then add "serial console=ttyS1,19200n8" to the end of kernel /vmlinuz in
/boot/grub/grub.conf.

For example:
kernel /vmlinuz-2.6.5-1.358smp ro root=LABEL=/ rhgb quiet serial
console=ttyS1,19200n8

This will result in all boot messages being output to the console ttyS1, but you will not see
All these boot messages on the local console until the login message prompts.
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c) LINUX OS:

(i) Add the following line into /etc/inittab.
s0:2345:respawn:/shin/agetty ttyS1 19200

(ii) Edit /etc/securetty and add ttyS1
. Host B with IPMIView installed:

a) Install and run IPMIView.
b) Log in Host A with the IPMI BMC installed as Admin.
c) Start Console Redirection in IPMIView immediately after the Host A reboots.

You will see the BIOS POST, the boot loader, and the Linux OS messages and prompts.
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10. KVM Console (KVM-Over-IP for Video Redirection)

KVM Console Redirection is a new feature included in the Supermicro Intelligent Management (SIM) Module.
If Video Console Redirection support is enabled, the remote screen will be redirected to IPMIView. BIOS
POST, BIOS settings, DOS, Windows or Linux OS screens can all be redirected to IPMIView.

Click the <Launch KVVM Console> tab to launch KVVM console redirection.
Figure 10-1 shows sample screenshots of Video Console redirection. The screen of a remote managed system

will be redirected to IPMIView. You will see the screen of the remote system just as if you were sitting in front
of the system.
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Toolbar
There are several tool buttons that can be used for video console as shown in Figure 10-2.

Start Video Redirection
1 Stop Video Redirection

4 Full Screen Auto Adjust Screen
T Screen Capture Options
Quick Shot

Open or Close Quick Shot Panel

| 192153.10.:49| T

@Q 00  +| @g% Crl+Aft+Del @[ Options

l Send Ctrl+Alt+Del to Remote
Zoom Out
Select Percentage for Scaling Screen
Zoom In

Figure 10-2 Video Console Toolbar

e 3 Start Video Redirection

This button is used to start video redirection. IPMIView will automatically start the video redirection
when you click the Video console tab.

° . Stop Video Redirection

This button is used to stop video redirection. To stop video redirection, press this button again to stop it.
Please note that the drive redirection will continue to work when it is enabled.

) Full Screen

This button is used to maximize the size of the remote video screen on the local computer display. You
may press <alt + enter> to return back to the original mode. Please refer to Figure 10-3.

Alt + enter

A
v

Figure 10-3
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o Screen Capture

This button is used to capture the screenshots of the remote managed systems. You will see a file-save
dialog box with a preview image. Select the directory and filename to save it. The file format can be

PNG or JPG.

® @ Quick Shot

This button is used to capture quick screenshots. You will need to first specify a directory where you
want to store quick shot images. You will see the quick shot images in the quick shot panel. Please refer

to Figure 10-4.
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Figure 10-4 Quick Shot

Open or Close a Quick Shot Panel

This button is a switch used for opening or closing the quick shot panel. Double click the image in this
panel to show a full-size window for viewing.

o ®% Zoom In

This button is used for zooming in the screen (up to 300%). Please refer to Figure 10-5.
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Figure 10-5
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o = Zoom Out
This button is used for zooming out. The maximum zoom out percentage is 10%. Please refer to Figure
10-6.
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Figure 10-6

o [100% | gelect percentage for Scaling Screen

This combo box allows you to select the setting of screen scaling, either 10%, 25%, 50%, 75%, 100%,
200%, 250% or 300%. An additional selection allows you to scale to fit with the IPMIView window size.

@ CUHAIDEl oo q Ctrl + Alt + Del to Remote

This button is used to send the <Ctrl + Alt + Del key >combination to the remote system. It is useful
when the remote system is running in the BIOS, DOS or Windows environment.

o @ Auto Adjust Screen

This button is used to adjust the screen automatically. Press this button if it’s difficult for you to see the
whole screen.

Optionz

o Options

You can select more options here. The list of options is listed below.

0 Monitor Only: Use this feature to display the remote screen only. The keyboard and mouse
will be disabled.

0 Readability Filter: This item uses algorithm to improve screen display. This will allow you to
see the text content easier when you scale the screen.

0 Local Cursor: Use this to change local cursor settings.

o Chat Window: This feature allows the user to chat with each other via the IPMI connection.
Please refer to Figure 10-7.
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17 192.168.10.24 Chat

| im@BIEM-IDCRA 107030 (super J=> test
root@linux(super )=> 456

Jim@IBM-DDCE410703D(super) | I~ Beep

Figure 10-7 Chat Window

0 Video Settings: This feature allows you to configure the advanced video settings. Please refer
to Figure 10-8.

Brightness 4] N 70
ContrastRed | 114
Contrast Green j 110
ContrastBlue 4| 112

|
|
|
|
Clock . | 1344
|
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_ = =
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Horizontal Offset _« | I 308
Vertical Offset  «| | 34

E"ﬁ'é'é'é'i"iﬁié'"f;i'6'&5"5\ Reset All Modes

Save Changes | 1,024x768 6OHZ Undo Changes

Figure 10-8 Video Settings

0 Refresh Video: This feature allows you to refresh the video screen.

o Soft Keyboard: A virtual keyboard is provided for easy input. It also provides localized
keyboard mapping. Please refer to Figure 10-9.
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Figure 10-9 Soft Keyboard

o0 Local Keyboard: This feature allows you to set local keyboard mapping settings.

o0 Encoding: This feature supports encoding for the video screen. The options for encoding are
“Predefined”, “Compression” and “Color Depth”.

Status Bar

Figure 10-10 displays the status bar for the video redirection.

Message Frames per second and In/Out bytes per second
Start Video redirection Fp=: 20 In: 184 KBi= Out: 204 Biz S

Share Mode l

Monitor Mode
Figure 10-10
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Start Video redirection
o Message

This section displays tool tip information and the video redirection status.

Fp=s: 20 In: 184 KB/= Out: 204 Bl=
o
This section indicates the number of the frames displayed per second, and Input (Kbytes per second)/

Output (bytes per second).

@ rl
o 44 ghare Mode
This icon indicates the status of screen-sharing on the remote system. If there is only one user using the

a
video redirection of a remote system, the icon will look like & | .If two or more users using the video
@ 'l
redirection of the same remote system, the icon will look like ad|

o
) Monitor Mode

O
This icon displays the status of monitor mode. When the display looks like , it indicates that you
can use the local keyboard and the mouse to control the remote screen. When the display looks like

% , it indicates that the local keyboard and the mouse are not available. If you select the option
“monitor only”, the keyboard and mouse will be disabled.
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11. Virtual Media

The Supermicro Intelligent Management (SIM) Module provides a Virtual Media feature, which
includes a Virtual USB Floppy, a CD-ROM image and Drive Redirection.

Figure 11-1 shows the Virtual Media GUI. The Virtual Media Status section displays the current virtual
device status. There are two virtual drives available.

Floppy Image Upload allows the user to upload a floppy image as "floppy" located at the remote host.
The floppy image uploaded shall be in the binary format with a maximum size of 1.44MB. It will be
loaded to the Supermicro SIM card and emulated to the host as a USB device.

The CD-ROM Image on the “Windows Share” allows the user to configure Windows-Share settings. It
allows you to decide how you want to share the data stored in your shared folder with the users on the
remote host system.

Drive Redirection makes local drives accessible to other users via console redirection. This function
allows you to share your local drives (floppy, CD-ROM and HDDs) with users on remote systems.

(= 107 168,10 341

Virtnal Media Statuz
Dirive 1 Drrpve 2
Tvpe : Floppy image Empty

Eead / Write mode: Witable
File name : flopper.img (1474560 btes)

Floppy Image Tpload CD-EiOb Image on Windows Share
Diopve: |2 =1 Open ] [ Tpload Dinve: E w
Flopper Image file: Share host:
CMloppyw img Share narme:
Path to fmage:
Upload flappy image done Tzer (optional);

Paszword (optional):

Dirive Fedirection
Drrive 1: Mot connected
Dirive Eedirection disconnected
Drive 2|  Connect Diive ][ Comnect [30 Mot connected
Dirive Eedirection disconnectzd
(@bt ] ®
Login | Event Log | Sensors | IPM Device | BMC Setting | Tsers | Text Conzole | VM Conmle | Viral Media
Figure 11-1
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e Floppy Image Upload

As shown in Figure 11-2, click <Open File> to select the file that you wish to upload to a specific host
drive of your choice. Click <Upload> to upload the floppy image. Please wait for the uploading process
to complete. The virtual floppy will be activated after the floppy image is uploaded.

Flappy Image Upload

Dirivvees
Floppy Image file:

Cfloppy g

Uploading floppy image

[ ]

Figure 11-2
® CD-ROM Image on Windows Share

Please refer to Figure 11-3 for the following items.

Drive: Specify the drive that you want the remote host to share.

Share Host: Enter the IP Address or the name of the system you wish to share data with via “Windows
Share”.

Share Name: Enter the name of the shared data in the remote host.

Path to Image: Enter the location of the source file that you wish to share via “Windows Share”.
User/Password (Optional): Enter the user and password for the person to access the data that you want
to share, and click the <Set> button to enter your selections as shown in Figure 11-3.

CO-ROM Image on Windows Share

Drive: 2 w

Share host: 19216510117
Share name: IS0

Path to image: [y e

=ser (optional):

Paz=sword (optional):

Figure 11-3
® Drive Redirection

As shown in Figure 11-4, Drive Redirection supports both local drive and the ISO file. When you click
the <Connect Drive>, a dialog will show up as figure 11-5.
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Local Drive List: This box displays a list of local drives available for remote access. Select from the list
a local drive that you want to make accessible for a remote server.

Refresh List: Click this button to refresh the local drive list.
Write Support: Check this button to allow the remote operating system to have write access to the drive
that you have selected. This function allows a user to alter, overwrite, erase and destroy data stored in

the drive selected. This feature should only be used with non-critical data. Select the drive and click
“OK?” to start direct redirection.

The second type of drive redirection is “Connect ISO”. You may redirect the ISO file directly from your
file system. Click this button and select an 1SO file to start this function.

Dirive REedirection

Drivel:[ Connect Dirive ” Connect T30 ]Hntmnmcted

Cancelled Drive redirection

Dirive 2:[ Comnmnect Dirive ][ Connect T30 ]Hntmnmcted

Dirive Fedirection discommected

Figure 11-4
:: Select a drive to redirect @

C: (Hard Disk) v [ Fefresh List ]

[ ] Enable Write suppart

| ok || Cancel |

Figure 11-5

® Stop Active Drives

As shown in Figure 11-6, click <Stop Drive 1> to disable Drive 1 and Click “Stop Drive 2” to disable
Drive 2. The <Refresh> button is used for refreshing the Virtual Media settings. If you want to stop or
change the type of a virtual drive, you first need to stop it.

| @ StopDrive! || @ StopDrive2 || Refresh |
Figure 11-6
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12. Group Management

Group management is a way to manage multiple servers at the same time. For example, you can query the fan
sensor readings from multiple servers and note their differences. Also, you can simultaneously power on or off
multiple servers at the same time. As shown in Figure 12-1, click <Manage Group> to show group
management. In group management, you can select multiple servers from the host group on the left and manage
them with the functions provided. You may re-arrange groups of servers in the group list to make server group
management easier.

:: IPMI Yiew ¥2.6.20 (build 070927} - Super Micro Computer, Inc.
File Edit Session PLENEECN Help

m e O @ 26

j Group Management

SUPERM]CR. Fon | Temperature | Voltage | Sensors | Event Log || ACPT | Power | LAN Config | FRT | Tesxt Console | General Info
ESALLAE N

Fan

IPMI Domain

Syrstern Name IF Sensor Name Reading Tnit Low Limit

25 Groups P
i TPMI Domain (44)

[ Refreshevery |60 | sconds

(et Virtual Media information done

Figure 12-1

In the group management, a Login ID and password are required. Click <Manage > Setting to set the login
information. Please note that IPMIView will use this account to login to multiple servers. (Figure 12-2)

Gronp Login Sethng

1) LognID ADMIN| |

Paszurard ;

save [0 and Password
* A dmnindstrator level is required,

| ok | [ Cancel |

Figure 12-2

IPMIView provides various tools for group management. As shown in Figure 12-3, group management can be
grouped to the following categories.
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Fans

Temperature
Voltages

Sensors

Event Log

ACPI

Power

LAN Configuration
FRU

Text Console
General Information

R R R

Group Management
Fan | Temperature | Yoltage | Sensors || Event Log | ACPI || Power || LAN Config | FRU | Text Console | General Info
Figure 12-3

. Fans

After you’ve selected multiple servers and clicked the <Fan> tab, a window will display as shown in
Figure 12-4. You can use <Ctrl+Click>, <Shift+Click> or draggin your mouse to select servers. Click
the <Query> button for IPMIView to collect the fan readings from the selected servers. The information
listed in the table shows the fan status of the selected servers. If a fan reading is colored in red, the fan
may be broken, not installed, or the reading is below the lower limit. When this occurs, the
Administrator should take precautionary measures to ensure that the system functions properly.

You may refresh the fan status by checking the Re-flash checkbox. IPMIView will refresh the fan status
based on a preset schedule. Please note that IPMIView will not refresh if you switch to another tab.

:: IPMI Yiew ¥2.6.20 (build 070927) - Super Micro Computer, Ine.

File Edit Session Manage Help
nEa oo R e
SUPERMICR@ [ 521 Manssermen
Fan | Temperature | Voltage | Sensors| EventLog | ACPI| Power | LAN Config | FRIT || Tesxt Console | General Info
SZETIE R L
Fen
Sustemn Name jig Sensor Name Reading Tnit Low Limit

192.168.10.241 192.168.10.241 [Fanl RPM 600

] 102168 10243 15216810241 (1921681024l 70 RPN 600
182.168.10.241 192.168.10.241 [Fan3 RPM 600
197.168.10341 192 168.10.241 [Fand EPM 600
182.168.10.241 192 168.10.241 [Fan5 RPM 600
197.168.10241 192 168.10.241 [Fenb RPM 600
182.168.10.241 192.168.10.241 FanTiCPU1 RPM 600
197.168.10241 192 168.10.241 FenBICPUZ 1800 RPM 600
182.168.10.131 192 168.10.131 [Fani RPM 600
192.168.10.131 192 168.10.131 [Fanz RPM 600
197.168.10.131 192 168.10.131 Fand ] EPM 600
192.168.10.131 192 168.10.131 [Fand RPM 600
197.168.10.131 192 168.10.131 [FanS EPM 600
182.168.10.151 192 168.10.131 [Fanf RPM 600
197.168.10.131 192 168.10.131 FentiCPU1 RPM 600
182.168.10.151 192 168.10.131 FanBiCPU2 RPM 600

=5 Groups B &b e

g IPMI Dowmedn (5/5)

[JRefushovery 60 [N seconds last updated 2007/10/01 15:59:06 (16)
Finish

Figure 12-4
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. Temperatures

The screen shown in Figure 12-5 indicates that multiple servers have been selected, and the Temperature
tab is pressed. Clicking the <Query> button allows IPMIView to collect the temperature readings from
the selected servers. The information listed in the table shows the temperature settings of the selected
servers.

T IPMI Yiew ¥2.6.29 (build 070927) - Super Micro Comprter, Inc. (=13
Flo Edit Sossion Meanags Help
BE A Qd@ R
SUPERMICR@ [ Sroub Hensaement
Fan| Temperstre | Voltsgs | Ssnsors| Bvent Log | ACPL| Power | LN Config | FRU | Text Consnle | Gensral Info
j—
= System Warms I Sensor Name Reating it High Limit
2 gg::gigg:i 102.168.10.241 192.168.10.241 FU Temp 1 50 degree C 750
Ll To2 16810241 [192.168.10 341 P Temp 0 Hegree © 750
To2 16810241 [192.168.10 341 P Temp 3 i Hegree © 750
To2 16810241 [192.168.10 341 0 Temp 4 i Hegree © 750
To2 16810241 [192.168.10 341 s Temp H Hegree © 750
To2 1810131 [192168.10 131 PO Temp 1 o Hegree © 750
To2 16810131 [192188.10 131 P Temp i Hegree © 750
To2 16810131 [192168.10 131 s Temp i Hegree © 750
125l Groups B&da
8 TFMI Domain (505)
[ Refresh svesy J— lstupdeted 200771001 155925 @)
Finich

Figure 12-5

. Voltages

After selecting multiple servers and < Voltages> settings, you will see the display as shown in Figure
12-6. Clicking the <Query> tab will allow IPMIView to collect the voltage readings from the selected
servers. The information listed in the table shows the voltage status of the selected servers.

07 [PMI View ¥2.6.20 (build 070927) - Super Micro Computer, Inc. [9(=1E3]
File Bit Sewsion Manags Help
HEa 00 2
1 Group Management
Fon | Temperature | Voliage | Sensors | EventLog | ACPI| Poer | LAN Config | FRU | Text Console | General Info
Voltge
System Name TP Sensor Neme Reading Tnit Low Limit High Limit
LEI= 102 168.10.242 192 168 10241 102.168.10241  |CPUL ¥ 122 [¥olt 1.08 161
7] 192 15810243 i ol
19216810241 (192168 10241 [PUZ Veome 0 Vols 08 161
10216810201 10216810241 [33V ¥ Volts 256 3]
19716810261 10216810241 5V 1 [Folis ] 549
192168 10241 10216810241 12V 1161 [¥olts 1075 1324
19216810241 19216810241 |13V 126 Vols SEX] -6
10216810201 10216810241 [15V a7 Volts L3 164
10716810261 10216810241 [5VSE 475 [Folis I 549
16216810241 192168 10241 [VBAT ) Vols 206 762
19216810131 19216800031 (CPUL Voo 136 Vols 08 161
102168.10.131 |192.168.10.131 [PUZ Veoxe q Volts 08 161
107168.10.131 |102.168.10.131 [537 7 [Folis 256 3]
16216810131 1921681031 [V ) Vols 11 549
19216810131 (162168 10131 127 V3] Vols 1075 334
102168.10.131 |102168.10.131 [5VSE 3 Volts 148 549
197168.10.131 |102.168.10.131 [VEBAT 15 [Folis 256 3]
=8 Groups Bdd&2
g [FMI Domain (545)
] Retresh svery sesonds Iost updated Z007/10/0L 15:59:27 (16)
Finich

Figure 12-6
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« Sensors

After selecting multiple servers and clicking the <Sensors> tab, you will see the window as shown in
Figure 12-7. Click the <Query> button for IPMIView to collect the sensor readings from the selected
servers. The information listed in the table shows the sensor status of the selected servers. The window
here shows the chassis status and power supply status. If the chassis is opened or a power supply has
failed, the reading will be in red.

D7 IPMI Yiew ¥2.6.29 (build 070927) - Super Micro Computer, Inc.

File Edit Session Manage Help
E A gde R
S C . Group Management
UPERMICR Fon | Temperatwe | Yoliage | Sensors | Event Log | ACEI| Power | LAN Config| FRU | Text Console | Genersl Info
IPMIDomain & ¥ 9 £ @ oM
102 168.10.240 Fower Suppy and [nfrusion
-E 41 Sstem Name IF Sl Status
il :gg i:: ig g:g 192.168.10.241 192.168.10.241 ntrsion hossis OF
192.168.10.241 192.168.10241 e Supply ower Supply O
192.168.10.13L 192.188.10.131 ntrosion Tessls Opened |
192.168.10.131 |152.168.10.131 covex Supply Porver Supply OK
Groups B& b2
Mg [P} Domain (5/5)
[ Refteshevery |60 8] seconds Lost updated 20071001 15:59:32 (4)
Finish

Figure 12-7

. Eventlog

After selecting multiple servers and clicking the <Event Log> tab, you will see a display as shown in
Figure 12-8. Click the <Query> button for IPMIView to collect the event logs from the selected servers.
The table below displays the event log of the selected servers. Select the <Host combo> box to filter the
event log data in the table.

O IPMI Yiew ¥2.6.29 (build 070927) - Super Micro Computer, Inc.
File Edit Sesson Manage Help

Ee 30 R0

Group Management

Fen | Temperaturs | Voltage | Sensors| EventLog | ACPI| Power| LAN Config| FRU | Text Console || General Info
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192168.10241  [192160.00241 0108007 142402Fd  Fan  [PowerS..jsoertion: Lower Non-critivel - going low
19216810241 (19216010241  DBA0007 142402Fd  [Fan  [PowerS..|hsertion: Loer Criticel - sning low
192168.10241  [192160.00241  DB102007 1424 02Fd  [Fan  [PowerS..|swrtion: Lawer Non-recoversble - going
16716610241  [197160 10241  |DG0G007 142403 Fd  Fan  [CPU O |sertion: Lower Hon-critical - going low
19216810241 (19216810241  D0/2007 1424 02Fd  [Fan  |CFUO... [hsertion: Lover Critivel - gning Iow
15716010241  [19216A 10241  |D@0/007 142402 Fd  [Fan  [CPU O |hsertion: Lower Hon-tecovershls - going
19216810241 (19216810241 0808007 1424 02Fd  (Fan  |Theoma...|sertion: Lower Non-criicel - going low
182160.10241 (10216000241  [DGAI0/2007 142402Fd  [Fan |Themme...kesertion: Laver Criticel - gving Jow
19216810241 (19216810241 002007 1424 02Fd  [Fan |Therma.. [hsertion: Lover Non-tecovershls - going
G & @ % | 19206810241 (19216010041  |0O102007 1424 00Fa  [Fan |Theoma... Assertion: Lower Non-eribicel - going low
i 17141 Dornsin (551 19216810241 (19216810241  [D8A0/2007 [42402Fd  [Fan |Themme.. [hsertion: Lover Critivel - gning low
192168.10241  [192160.00241 0102007 1424 02Fd  [Fan |Theoma.. [kswertion: Lawer Non-recoversble - going
15216610 241 E 16810241  DAI0M007 143434 Fr  [Fan  [FanS  |Assertion: Lower Non-critical - soing low

192.168.10.241 192.168.10.241 08/10/2007 14:34.34 Fri Fan FanS Asgsertion: Lower Critical - going Jow
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< bd
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Finish

Figure 12-8
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. ACPI

After selecting multiple servers and clicking the <ACPI> tab, you will see a display as shown in Figure

12-9. Click the “Query” button for IPMIView to collect the ACPI state from the selected servers. The
table displays the ACPI state of the selected servers.

DT IPMI View V2.6.20 (build 070027) - Super Micro Computer, Inc.

Fik Edit Semion Massge Help

fmagDne e
SUPERMICR@ [ ©reep Mensaement

Foa | Tempeenture | Voliage | Senwies | Event Log| AT | Powes | LAN Costig | FRU | Text Comule | Gearsad lafo.
R k-X FEAE

ACH

Syvtem Hame ¥ ACFISlle  Demoghon  OndOff

19216810241 192168 10241 20100 wuihang
192168.10.131 192,168 10131 20100 wuikang

ﬁam Rade

1EM1 Dommazn, (545)

[ Refmshevery |60 w secomds ot updated 20071001 160205 @)

Figure 12-9

. Power

After selecting multiple servers and clicking the <Power> tab, you will see a display as shown in Figure

12-10. Click one of the power <Control> buttons to send a command to the selected server. The text
area will show the result.

D7 IPMI View ¥2,6.20 (build 070927) - Super Micro Computer, Inc, =15

Fik i Semon Miage Help

SN
SUPERMICR@ 7 Sreep Mensaement

Fan|| Tempesbus | Yoliage | Senoor| Evenl Log | ACFL| Power | LAK Confg | FEU | Tet Consle | Gemeal lufo
A IPRA| Dicarmasin A w QB @y | Omcefol Fower Contl

wcen || ][ | [ Gmeeful Pawes Cele |

[ owmibowa ][ PwwmUp ][ PowmCrmk | [ Eemt ]
Renlt
[2007110/01 16:02:42] Sending Power Lip to 192.168,10.241, . Ok
[2007A10/01 16:02:42]) Sending Power Lip to 192.168,10.243, . Ok

Gaonas Béd
IPMI Domain (5)

Finich

Figure 12-10
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. LAN Configuration

After selecting a single server and clicking the <LAN Config > tab, you will see a display as shown in
Figure 12-11. Click <Query> to get the information needed from a single server and copy it to other
servers for data-sharing. The text area will show the results of the query and provide updates. The
<Clear> button is used to clear the text field only; it will not clear the actual LAN configuration from the

Server.

. FRU

After selecting a single server and clicking the <FRU> tab, you will see a display as shown in Figure 12-
12. Click the <Query> button for IPMIView to get the FRU information from a single server, and copy
it to other servers for data-sharing. The text area will show the results of a query and provide updates.
The <clear> button is used to clear the text field only; it will not clear the actual FRU data from the

Server.

D7 IPMI View ¥2.6.29 (build 070927
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Figure 12-12
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. Text Console

After selecting a single server and clicking the <Text Console> tab, you will see a display as shown in
Figure 12-13. Click the <Open> button for IPMIView to create an internal text console window for the
selected server. Click <Start> to start the text console redirection. The power control buttons displayed
on the status bar provides power on, power off and reset commands, allowing you to easily power on or
power off a remote server. The <Encode> checkbox is for RMCP+ encoding. Check it to enable packet
encoding between the IPMIView and a server.

O IPMI Yiew ¥2.6.20 (build 070927) - Super Micro Computer, Inc.
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Figure 12-13

Finizh

. General Information

After selecting multiple servers and clicking the <General Info> tab, you will see a display as shown in
Figure 12-14. Select the fields you want to query from the servers, and click the <Query> button to
allow IPMIView to collect the information from the selected servers.

;: IPMI Yiew ¥2.6.29 (build 070927) - Super Micro Computer, Inc.
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Figure 12-14
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13. Trap Receiver

The Trap Receiver is a utility used for receiving traps from the BMC. In the event of a sensor error or a
sensor reading that exceeds a threshold, the BMC will send SNMP traps to the destinations set in the
BMC. The Trap Receiver is executed on the destination site and receives the SNMP trap from multiple
senders (BMCs). If you select a category, you can see all the traps in that category. Furthermore, when
you click a trap in the trap list, you can see its details in the <Trap Structure> window. Please refer to
the BMC Setting page in IPMIView to set the SNMP destination.

As shown in Figure 12-1, there are several components to the IPMI Trap Receiver.
1) Menu Bar: contains pull-down menus for exiting the programs, getting help, etc.
2) Tool Bar: contains all IPMI Trap Receiver features.

3) Category: categorizes the traps by the sender, community and sensor.

4) Trap Structure: It is a tree structure that displays traps in detail.

5) Status Bar: shows messages regarding the current status of related components.
6) Trap List: shows detailed information for traps received.

o IPMI Trap Receiver ¥2.0 (build 051122) - Super Micro Computer, Inc.
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Tra p & length: 109 15 19216810245 |public FARN 4 Lovwer Critical - going low 2005¢ 0001 15:49:31 ...
Structure —] # Erterprize: 1.3.6.1.4.1.318 19 19216810245  |public FAN 4 Lower Non-recoverable - going lowe (200510001 15:49:32 ..
& Agent P 1592.165.10.245 =20 19216610245 |public CPUA Upper Mon-critical - going high 2005M 0001 15:49:49 ..
# Genetic Trap Type: 6 21 19216810245 |public CPUA Upper Critical - going high 2005M 001 15:45:50 ...
# Specific Trap Type: 262400 22 19216810245 |public CPUA1 Upper Mon-recoverable - going high (200510001 15:43:50 ...
& Timeticks : 1128180277 23 19216810245 |public FAN2 Lowver Mon-critical - going low 20051 0J01 15:30:07 ...
= _| PO Bocly 24 19216810245 |public Fam 2 Lowver Critical - going low 2005M 0001 15:50:08 ...
# Total Length of Variable Bir 25 19216810245 |public FAN 2 Lowver Mon-recoverable - going lowe (200540001 15:50:10 ...
= _| Bind 26 19216610245 |public FARN 4 Lovwver Mon-critical - going low 2005M 0001 15:50:22
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Status Bar : ——
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Figure 12-1
® Tool Bar functions

The tool bar provides the following features as shown in Figure 12-2.

> @ O a mn

Stop Save Load Clear Etmail
Figure 12-2

O Start: starts the Trap Receiver.
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Stop: stops the Trap Receiver.
Save: saves the traps received into a file.

Load: loads a saved trap file into the Trap Receiver.
Clear: clears all the traps in the trap list.

Email: displays an “Email-Alert Settings” dialog box (see Figure 12-3). Fill the “SMTP
server”, “From (email address)” and “To (email address)” fields. The “From” and “To”
addresses must be valid in the SMTP server. If the SMTP server requires authentication,
please enter the username and password. Once entering needed information, click the <Test>

button to verify if your email works properly.

® (Category

There are three categories including: Sender, Community and Sensor as shown in Figure 12-4. The
Sender page lists all sender IP addresses. The Community page lists all SNMP communities. The Sensor
page lists all sensor types from the traps. Clicking on each category type will act as a filter for all traps

Email Alert

Email Alert Setting
[ Enakle Email Alert

SMTP Server:

From:

Tar

3

[] Authentication
Usarhatme:
Pazsward:
Figure 12-3

in the traps list. Click the <AlI> button to cancel all filters.

Category

2l
# 19216510245
& 19216510247

All

Category

&)

# public

Sender | Community || Sensar

Once a category has been selected, the filter condition will be displayed at the bottom of the “trap” list.
See Figure 12-5 for reference. As displayed in Figure 12-5, the filter is “Sender = 192.168.10.245,

Zender | Compunty | Sensor

Al Category
&1
# FAMN4
Far 3
Fam 2
CPU
Fam 1
Far 5
Far G
Fam 7
FAr &
Intrusion

LR R R R R R

Sender | Community | Sensor

Figure 12-4
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Community = public, Sensor = CPU 1”. The trap list displays only those traps whose contents are
included in each of the three filters.

Mum Sender Community Sensaor Description LocalTimeStamp

10 19216510245 |public CPL A Upper Mon-critical - going high 2005710001 15:46:22...
11 19216810245  |public CPUA Upper Mon-critical - going high | 2005410001 15:46: 25
12 182.165.10.245  |public CPU A Upper Critical - going high 20050101 15:46:26...
13 19216810245  |public CPUA Upper Mon-recoverable - goi... 200540001 15:46:28...
20 19216510245  |public CPU A1 Upper Mon-critical - going high | 2005110001 15:49:49...
21 19216510245 |public CPL A Upper Critical - gaing high 20051001 15:49:50...
22 19216810245  |public CPUA Upper Mon-recoverable - goi... 2005410001 15:49:50...

Sender = 19216510245 | Community = public | Sensor = CPU 1

Figure 12-5

® Trap Structure
The Trap Structure displays detailed information for the selected item in the trap list. Information
includes the “SNMP Header”, “PDU Header”, “PDU Body”, “Bind” and “PET” data.

Trap Structure

|1 SMMP Trap
= || SNMP Header

# Mezzage Length: 125

# Meszage Version: vi

& Community: poblic

= || PDU Header
Type: Trap
lenigth: 109
Enterprise: 1.36.1.4.1.3183.1 1
Agent [P 192168.10.245
Generic Trap Type: B
Specific Trap Type: 262400
Tireticks ;1128180281
= || PDU Body
# Total Length of Yariable Binding: 72
= || Bind
# Length of Binding: 7O
# 0136141318311
= || FET Data
# [FAM 3] Lower Mon-critical - going low
& [0 @2 TF] @ [ 0x 0= 0x0x

LR B R

Figure 12-6
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® Receiving a Trap
When the Trap Receiver receives a trap from the BMC, an alert bar will display on the screen for about
10 seconds to notify you that a trap has occurred. In addition, an email alert will be sent according to the

information field in the Email Alert dialog box. Please refer to Figure 12-7.

The content of the email will include the following information.

A SNMP trap received

Sender:192.168.10.247

Sensor:FAN 2

Description:Lower Non-recoverable - going low
Time:2005/11/22 14:27:07 Tue

¥ IPMI Trap Receiver ¥2.0 (bunild 051122) - Super Micro Computer, Inc.

File Help
> ®@ B s o =
Stop Save Load Clear Etnail
Category Al um Sender Cormmunity Senzor Drescription LocalTimeStamp
| 2 19216510, [puklic Far 4 Lowver Critical - going low 200510001 15:24:3..
# 19216510245 3 19246810, |public FARN 4 Losaver Mon-recoversble - goi... 20050001 15:24:4 ..
& 19216510247 4 192 165.10.... |public FAM 5 Lowwer Mon-critical - going lose (200540001 15:24:4 ..
- O AR AR el lis Toahta tomeeme St sl (O 20051001 15:24:4..
ATrap Received rable - goi.. (20054 0/01 15244
Sender: 19216210247 - going losy [2005M 001 15:46:1 ..
Sender | Cormunity | Sensor Z% Content [ FAN 2] Lower Critical - going low nglowe  2005A0M1 15461
rable - goi... (200510001 15:46:1 ..
Trap Structure T T92 66 T0... [FUIC RO CRRIEr MUFFCHOCET - going high  [200540/01 15462,
;| SMMP Trap A 11 192165810, [puklic CPU A1 Upper Mon-critical - going high (200500001 15:46:2...
= ] SMMP Header 12 192 165.10.... |public CPU A Upper Critical - gaing high 20050001 15:46:2...
# Message Length 125 13 19246810, |public CPU Upper Mon-recaverable - goin... 2005001 15462,
# Message Version: wi 14 192 165.10.... |public FAM 5 Lowwer Mon-critical - going lose (200540001 154932,
# Community; public 15 192165810, [puklic FAM 3 Liowwer Critical - going low 2003001 15492,
=2 _| PO Header 16 19216510, [puklic FAM 35 Lowwer Mon-recoverable - goi... [2005M0/01 154932
& Type Trap 17 192165810, [puklic FAN 4 Lowwer Mot-critical - gaing o (2005001 15492,
# length: 109 15 192 165.10.... |public FAM 4 Lovwver Critical - aaing low 200510001 15493
# Enterprize; 13614131 19 19246810, |public FAN 4 Losaver Mon-recoversble - goi... 20050001 15:49:3..
# Agent IP: 192 16810245 20 192 165.10.... |public CPU A Upper Mon-critical - going high (200540001 15:49%:4 ..
# Generic Trap Type: 6 21 19246810, |public CPU Upper Critical - gaing high 20051001 15495,
# Specific Trap Type: 262« 22 192 165.10.... |public CPU A Upper Mon-recoverable - goin... 200510/01 154935
# Timeticks ; 1128180277 23 19246810, |public FARM 2 Losaver Mon-critical - gaing lowy 20050001 155000,
= ] POU Body 24 192 165.10.... |public FAM 2 Lovwver Critical - aaing low 2005M0/01 15:50:0...
# Total Length of Yariakle 2 25 19246810, |public FARM 2 Losaver Mon-recoverable - goi... 200500001 155001 ..
£ ﬁl e 3 | |sender =+ , Community =* | Sensor = *
A Trap Received; Sender P =192.1658.10.247 cortent = [ FAN 2 JLower Critical - going how Senditig Email ...

Figure 12-7
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Appendix A: SIM Firmware Update

1. Select a remote system on the System list and click “File > Update IPMI Firmware” to start the
firmware update.

IZIEN Edit Session  Manage

Mew... [
Discover IPMI Device

Reload Confiziration
Save Configuration

Tpdate TP Fiomware

Exit
Figure A-1

2. Click the <Open> button to select the<firmware> you desire and then click <Start> to continue.

:: Dpdate Firmware E]

IP: 192.168.10.249

Firmweare File: | | [ Open H Start I

Message:

Figure A-2

3. A login dialog will appear. Please enter the Login_ID and the password. This user will be granted the
privilege as an Administrator.
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@ Lagin IO | ADMIN |

Paszsword rk

* &dministratar level is required

| oK | [ Concel |

Figure A-3

4. A firmware information dialog will appear. It shows detailed information on the current and new
firmware. Click <Yes> to continue.

Request Confirmation g'

Curresnt firmware:
Firmware Version: 1.5.0 build 4238

Firmware Tag: Aug-14-06-17-30
hardweare ID: 0x22
QEM: peppercon

Mew firmware:

Firmuware Version: 1.5.2 build 4238

Firmware Tag: Ang-16-06-11-10

Firmware Size: 3092370 bytes

Firmuware Path: C:\fw-kira-kimsmigd-smidc-peppercon_040200-4238-081606-1-5-2 bin

Would vou like fo continue ?

Figure A-4

5. The firmware file will start to upload. This process may take few minutes to complete.

TP: 192.168.10.249

arcon_040200-4235-081606-1-5-2.hin |

Firmware File:

Uploading firmaware

[IIIIIII ]

Message:

Login to 192.168_10.240
tart firmware upgarde
Mploading firmware ...

Figure A-5
6. Please wait for the firmware to upload. Once uploading is completed, the BMC will start to flash the

firmware internally. This step may take about a minute. Please try to connect to the system after two
minutes.
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Appendix B: SIM(W) KVM Console and Virtual Media

SIM(W) KVM Console allows the user to perform console redirection via KVM
(Keyboard/Video/Mouse) support as shown in Figure B-1.

Zj IPMI ¥iew ¥2.7.13 (build 100504) - Super Micro Computer, Inc.

File Edit 3Sesdon Manage Help

® ®

e agd @
IPMI Domain

SUPERMICR®
D

= 172.31.1 .42
& 172.31.143-1
o8] 172.21.2.123
5] 172.31.2.145
o] 172.31.2.146
o3 172.21.162
o 172.31.2.31
Tl 17231258
ol 172.21.2.59
ol 172.31.2.62
T 172.31.2.181
= 10716810118
=) 192.168.10.99
& 192.168.10.30
& 107.168.10.50

-~

T T

AvQRD

=5l Groups & &
| TPMI Do ...

New Groupl (2107

Wew GronpZ (47

e New Group3 (3/2Z)

EMCP+ Open Sessdon successful

5 192.168.12 169

@ @2 [ Fulsorson [Z] Virtoel bodia [B] Soft Keyboard

13
14
15
16

C:in>ipmicfg —sdr >aa

C:N>type aa
3DR ID i Sensor

Redirection Viewerstarted...

Login | Event Log | Sensors | [PM Device | BMC Setting | Users | Text Console | KVM Consle

12
13
14
17

g
1@ i
11
12 i
13 i
14 |
17 i

# i Sensor

2 1 CPUZ Temp

3 | Bystem Temp
4 i CPU1 Vcore
5 !

6 1 +12V

7?0 +3.3V

8 | DIMM

4 fps E Menm

Fanl
Fan2
Fan3
PS Status

675.00 RPM
0.00 RPM
0.00 RPM

i OK [00 CO 0O 0O]

i Reading
i nsa [0O

36.00
.12
.00
.31
.23
.81
.06
.23
.23
.00

E0 07 001
degree C

CPUZ Ucore

[

+5U
+3.3USH
UBAT
Fanl

FanZ

Fan3

P3 Status

o
=]
o WWN R WE O

RPM
RFM
RPM
i DK [0 CO 00 08]

Figure B-1 SIM(W) KVM Console Main Screen

SIM(W) Console Toolbar

The SIM(W) Console Toolbar provides seven tool buttons which will allow the user to perform the
following actions as shown in Figure B-2.

Start Video Redirection

4

A

' Stop Video Redirection

. Screen Shot

A

F

O @9 QIFUHScreen B Wirtal Media Boft Eevhoard

Refresh (the page)

AII Screen (display)

Virtual Media (to use Virtual Media)

Soft Keyboard (to use the soft keyboard)
Menu

1ipz E Menn

Figure B-2 SIM(W) KVM Console Toolbar
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o [} Start Video Redirection

Click this button to start SIM(W) KVM console redirection.

o O Stop Video Redirection

Click this button to stop video redirection. Please note that the drive redirection will continue to work
when it is enabled.

] QI Full Screen

Click this button to maximize the size of the remote video screen displayed on the local computer screen
as shown in Figure B-3.

]

12 | Fanl I 675.00 Rrikd =4 192.168.12.169 - 4fps
13 i FanZ i 0.00 RPM

14 | Fan3 H ©.00 RPH

17 § PS Status i OK [0B CO 80 601

C:\>ipmicfg -sdr >aa

C:notype aa
i Sensor i Semsor i Reading
i i CPUZ Temp i nra [00 EO 07 001
i System Temp i 36.00 degree C
i CPU1 Ucore i 1.12 v
i CPUZ Ucore i 0.00 U
11.31 v
3.23 v
1.81V
5.06 U
3.23 v
i 3.23 U
i 675.00 RPM
i 9.00 RPM
i 0.00 RPM
i PS5 Status i 0K [00 CO 00 00]

Figure B-3 Full Screen
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) Virtual Media

Click this button to enable Virtual Media support as shown in Figure B-4.

Virtual Media
“4 Virtual Media X

FloppwUEE Eey Media
@ Floppy Image Browss | | ComectFlompy |

CD Media

() IS0 Image | Bowse | [ CommctCDDYD
OF
OF

Statos

Target Dirive Connected To Eead Bates

irtual Floppy Mot connected nfa
Wirtnal CD Mot connected nfa

Cloze

Figure B-4 Virtual Media

Floppy/USB key Media: This feature allows the user to redirect Floppy/USB Media.

CD Media: This feature allows the user to redirect CD/DVD or ISO image file.

Connect Floppy: Click this button to start to redirect your Floppy Image or USB Key Media.
Connect CD/DVD: Click this button to start to redirect your CD/DVD or ISO image file.

O O0OO0oOo

o Blgoft Keyboard
Click this button to use the Soft Keyboard for console redirection as shown in Figure B-5.

Combination (of Keys)
Lock (Hold Modifier Key)

Soft Keyboard v0 96

Language odifier Kew(Ctl, lt, Shiff, Win, Prtic)
|Eng].ishl{'LTnited States) 7 | (%) Combination [JLaock
() Single Key

E& Fl |F2 |F3 |[F4 | F5 |FT5 |FI" |F8 | Fd |F10|F11|F12 P [Scrl)Pan
"1 |2 S A G £ |T" |E 9 (0 = BE Inz (HonPUp Mun/ |*
T - =R O N | 17 S S ] T ([ ! Del |End|FD Hon it |FUQ
Capiil S S < S O O o 1O 1 1 | < + = = |4
Shaft 2] = O T ] L |/ Shaft 1 End 8 |PD
Ctrl | Wi Alt ATt | Winy App Ctrl = [} |= | Inz Dl [

Figure B-5 Soft Keyboard
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Language: This feature allows you to select a proper language setting for your soft keyboard.
Combination: Check this button if you want to use a combinations of modifier keys

Single Key: Check this button if you want to use a modifier key as single key.

Lock: Check this button to hold the modifier key you’ve clicked.

O oO0O0oo

The menu is same as web KVM UI.
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Appendix C: SIM(WA) iKVM Console and Virtual Media

Press <Launch KVM Console> to open SIM(WA) iKVM Window as in Figure C-1.

T IPMI View ¥2.7 13 (build 100504) - Super Micro Computer, Tnc_
File Edit Session Manege Help

nEa gl Re

- |1 2 192,160 12.168| & 192.188.12.125
SUPERM ICR. Console Redirection

iy IPMI Domain = & % § £ @
l_m 17231262 ~
iﬂ 172312181
= 197 168.10.118
& 192.168.10.30
& 192.168.10.50
& 17231217

& 172312161
& 17231173

17zl
5 iz Press the button b lnunch the redirection console end e el
10216810 174 & Press the button o leunch the redirection eomsol manage the server remotely.
02138183134
) 102168 10 168 Lanch KVH Consols
i1
1723136
SR EIREE
11 21 A4 A1

Login | Event Log | Sensors | TPM Devics | BMC Setting | Tsers | Tesdt Conools | 73 Consals |

RMCP+ Open Session successful

Figure C-1 SIM(WA) iKVM Window

Please note that SIM(WA) iKVM window supports same features as other versions of Web KVM as
shown in Figure C-2.

Java iKYM Yiewer v1.5517 [192.168.12_125] - Resolution 652 X 492 - FPS 0
> Virtoal Media ~ Eecord  Plawback  Macro  Optons  Tser List  Exit

Press any key to enter the menu

Booting Cent0S (Z.6.18-164.e15) in 3 seconds...J]

Figure C-2 iKVM Window
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® Virtual Media (USB Floppy & Flash)

Click <Virtual Media> on the menu bar and then click <Virtual Storage> to display the Virtual Media
(USB Floppy & Flash screen) as shown in Figure C-3.

Yirtual Media 1.2 12

Setting for Device 1
Logical Drive Type Image Filename and Full Path
Na Select L%
u R T

Connection Status History

£ >

Figure C-3 Virtual Media (USB Floppy & Flash)

0 Logical Drive Type: From the pull-down menu select the logical drive type.

o Image Filename and Full Path: Enter the image file name and the full path to the file. It is
available only for 1SO files.

0 Refresh: Click this button to refresh the page.

0 Plug In: Click this button to mount your logical drive as virtual media.

0 Plug Out: Click this button to un-mount virtual media.

0 OK: Click this button to confirm and exit.

o Connection Status History: This window displays the connection and the status of virtual

media.
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® Virtual Media (CDROM & ISO)

Click < CDROM & ISO > to display the Virtual Media (CDROM & 1S0O). as shown in Figure C-4.

Yirtual Media 1.2 12

Setting for Device 2
Logical Drive Type Image Filename and Full Path
|N0 Select £ | | |
[ ] [ i

Connection Status History

< >

Figure C-4 Virtual Media (CDROM & ISO)

Logical Drive Type: From the pull-down menu select the logical drive type.

Image Filename and Full Path: Enter the image file name and the full path to the ISO file.
Refresh: Click this button to refresh the page.

Plug In: Click this button to mount your logical drive as virtual media.

Plug Out: Click this button to un-mount virtual media.

OK: Click this button to confirm and exit.

Connection Status History: This window displays the connection and the status of Virtual
Media.

O O0OO0O0O00O0

® [KVM Virtual Keyboard

Virtual Keyboard provides soft keyboard support and allows the user to click a key on the soft keyboard
by using the mouse when a keyboard is not available. Refer to Figure C-5 for Virtual Keyboard.

Englizh keyhoard |Z| |E|rz|
1234|516 |T|8 |90 |- |=]| +— |fins|" |t (k| S |*
rolalwle | [tlyluliloln|r]n ]y |let |7 SHEBR
JLjals|d|f|g|h|j|k Y - —| |—=
T lz|x|c|w|b|a|m|,|.|! ul} T S U F
ctrl |#| alt At |o| Bl e[| 4= o Bell *

Figure C-5 Virtual Keyboard
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Appendix D: SIM(W) Firmware Update

To re-flash SIM(W) Firmware, please select an SIM(W) device and <Update firmware> in the menu.
Then, click <OK>. A dialog box will display as shown in Figure D-1.

Confirmation

- | ) This iz BIM (W device. Pleaze make sure wom have comect firmware for vpdate {* dma)

| 0K || Comeel |

Figure D-1 SIM(W) Firmware Re-flash
YAFU Flash

1. To flash Hermon Firmware, The YAFU Flash Main screen will display as shown in Figure D-2.

Y AFTIFlazh [5_<|
Remote Flash Tool for Hermon/AM FUWW T171
IF: |192.168.12.159 | Options
[ ] Preserve Bootloader
File: | | [ Browse. . ]
[ ] Preserve Config Module

Figure D-2 YAFU Flash Main screen

2. After you’ve selected a firmware file for remote flashing, it will be checked if it is a valid file before
remote flashing starts.
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Y AFTTFlazh E'
Remote Flash Tool for Hermon/AM FUWW T171
IF: |192.15=3.12.159 | Options
- : [ ] Preserve Bootloader
File: | DAFWAMIEIDCT-L_130ima | [ Browse |
[ ] Preserve Confiz Module

Mew fimmaware verson ; 1.30

]

Figure D-3 YAFU Flash (2)

o

IP: This item displays the IP Address of the IPMI device.

Browse: Enter the file name or browse the data base to select a file that you want to perform
remote flashing.

Preserve BootLoader: Check this box to preserve the settings of BootLoader.

Preserve Config Module: Check this box to preserve the settings of Configuration Module.
Firmware Version: The new firmware version will be displayed.

Flash: Click <Flash> to commit the file for remote flashing.

@]

O o0O0o

3. Remote Flashing can only be performed by an Administrator. If you are an administrator, enter your
ID and your password in the screen below. Then click <OK>.

Please imput [I and Fassword [5_(|

9y LognlD | |
“‘-f(/ Pazswrond | |
* b dnindsteator level iz reqguired

| ok || Comel |

Figure D-4 1D and Password (Administrator)
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4. Check the current firmware version. The current firmware version will be displayed as shown in
Figure D-5.

Y AFUFlash [z|
Remote Flash Tool for Hermon/AM FW 121
IF: [192.168.12.169 | Options
[ ] Preserve BootLoader
File: |D:'-.FW'-.AMI‘-.K".-‘DC T-L_130.ima | [ Erowse... ]
[ ] Preserve Confiz Module

Mew fimmaware verson ; 1.30

| FW Version |

Current firmweare verson: 1.30

Figure D-5 Display of Current Firmware Version

5. Once you’ve checked the firmware versions and clicked <Flash>, Y AFUFlash remote flashing will
start as shown in the screens below.

Y AFUFlash x|

Remote Flash Tool for Hermon/AM FW ¥l21

IB: 19216812 169 | Options

File: |D:".FW".P;MI".K?DCT-L_13EI.ima|

Mew fimware verson ; 1.30

Current firmyware verson: 1.30

Statos: 7% ( 1,310,720 bytes / 16,777,216 byvtes )

LLLI ]

Femaining Time: 6 minz) 47 w@ciz

Figure D-6 Remote Flash Screen #1
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¥ AFIFlazh

X

Remote Flash Tool for Hermon/AM FUW V131

P (19216812169 | Cptions

Preserve Bootloader
File: |D:".F1.?'.T".AMI".K'.-‘DCT-L_13IZI.m| Browse

Fresrve Confiz Module
Mewe firmwsare version ; 1.30

Crrrent firmeware version: 1.30 FW Version

etatnz: 22% (2,801,088 bores ! 16,777,216 baes )

Femadning Time: 5 minds) 41 zeciz)

Figure D-7 Remote Flash Screen #2

Y AFUFlash f'>_<|
Remote Flash Tool for Hermon/AM FW V121
IF: |192.168.12.169 | Options

Prezserve Bootloader

File: |D:".FW'\P;MI".K'?DC T-L_130.ma | Browss...

Fresrve Config Module
Wew firmyeare version : 1.30
Cprrent firmeware version: 1.30 FW Version
Statuz: 51% (8,585,216 botes / 16,777,216 bodes )
BERRRREEEEERRREEEEERRRREEEER
Femaining Time: 3 minfz) 35 ez Flash

Figure D-8 Remote Flash Screen #3

Y AFUFlash X
Remote Flash Tool for Hermon/AM FW Y121
IP:  [192.168.12.169 | Cptions
Preserve Bootloader
File: |D:".F1.?'.T".AMI".K".-‘DC T-L_130 ima | Browse

Fresrve Confiz Module
Mewe firmwsare version ; 1.30

Crrrent firmeware version: 1.30 FW Version

Sfatuz: Findshed . (BMC needs 1 minute to restart)

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIllllllllllllllllllllﬂ

Figure D-9 Remote Flash Screen #4
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Appendix E: SIM(WA) Firmware Update

1. Select an SIM(WA) device and select <Update Firmware> in the menu for SIM(WA) Firmware Re-
flashing. A screen will display as shown in Figure E-1.

Confirmation

"l ) Thiz iz SIM(WLY device. Please make sure wow have cormect firmware for vpdate (*.bin)

0K || Comcel |

Figure E-1 Firmware Update Screen

2. Make sure that you’ve selected the correct firmware for update, and click <OK>. The Main Flash
Screen will display as shown in Figure E-2.

Flash Tool [5_(|

Remote Flash Tool for Hermon/AT FW Y120

IF: |192.168.12.125

il

File: |

Browese. .

F Yersion

(—

Figure E-2 Main Flash Screen

3. After you’ve selected a firmware file for remote flashing, it will be checked if it is a valid file before
remote flashing start.
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Flazh Tool E'

Remote Flash Tool for Hermon/AT FW Y120

IF: |192.15=3.12.125 |

File: |D/FWALTEN®BDTL 817 bin |

Mew fimmaare verson ; 01.15

Figure E-3 Main Flash Screen

4. Remote Flashing can only be performed by an administrator. If you are an administrator, enter your
ID and your password in the screen below. Then click <OK>.

Please input IT) and Password ['5_('

2, LoginlD
v

Pazzurond
* b dmindztrator level iz required
| oK || Comeel |

Figure E-4 ID/Password Screen

5. Check new and current firmware versions. The firmware versions will be displayed as shown in
Figure E-5.

Flash Tool ['5_(|

Remote Flash Tool for Hermon/AT FW Y120

IF: |192.168.12.125 |

File: |D:'-.FW'-.ATEI-I‘-.KBDTL_81?.hm | Browse

Meww firmware version ; 01.15

Current fimmware version: 01.10

Figure E-5 Firmware Versions
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6. Once you’ve checked the firmware versions and clicked <Flash>, firmware flashing will start as
shown in the screens below.

Flash Tool b—('

Remote Flash Tool for Hermon/AT FW Y120

IF: |192.168.12.125 |

File: |D:'-FW'-.ATEI-I‘-.KBDTL_81?.hm | Erowse

Mew firrware version ; 01.15

Current firmware sersomn: 0110 FI Verson

Statnz: Uploading...

(k) ]
Flazh
Figure E-6 Remote Flash Screen #1
Flazh Tool ['5_(|
Remote Flash Tool for Hermon/AT FW Y120
IF: |192.168.12.125 |
File: |D:".FW".ATEI'I".KED TL_817 hin | Browe
Wew firmware verson ; 01.15
Current firmware version: 01,10 FW Verson
Statnz: Updating. ..
- T 1
Flazh

Figure E-7 Remote Flash Screen #2
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Flash Tool [i|
Remote Flash Tool for Hermon/AT FW Y120
IP: |192.15=3.12.125
File: |D:".FW'-.ATEI-I'-.KED TL_817 bin Browss.
Mewe firmware version : 01.15
Current finmssare sersion: 01.10 F Verson
Statnz: Updating. ..
I 1
Flazh
Figure E-8 Remote Flash Screen #3
Flazh Tool [?|
Remote Flash Tool for Hermon/AT FW Y120
IF: |192.168.12.125
File: |D:~EW~MEM§BD TL 817 bin | Er—
Mewy firmeware verson : 01.15
Current finmsare serson: 01.10 FW Verson

Status: Findshed

NG

Cloze

Figure E-9 Remote Flash Screen #4
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